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Micro Focus Academic Program 3.0 -
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Overview

The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.

COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.

The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.

This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.

Welcome! We’re excited to have you join our growing academic community.

Product Description

The Micro Focus Academic Program Edition package comprises the following products:

• Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.

Variants of Visual COBOL include:

• Visual COBOL for Visual Studio 2012, Visual Studio 2013, Visual Studio 2015 or Visual Studio 2017
• Visual COBOL for Eclipse (Windows)

• Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:

• Enterprise Developer for Visual Studio 2012, Visual Studio 20132012, Visual Studio 2015 or Visual
Studio 2017

• Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:

• You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.

• An authorization code for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.

For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.

Reporting Issues

• For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• AppMaster Builder
• CICS Support
• Compatibility AddPack
• Compiler
• Documentation
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• IDE
• IMS Support
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• OpenESQL
• PL/I Support
• Reserved words
• SQL: HCO for SQL Server

AppMaster Builder

Back to the list

• A new parm "STS" can be passed into the Program Generator. This parm tells the Program Painter to
issue an error when it encounters a STUB keyword and the stub program is not specified in the
application definition. This new parm is specified in the ISPSLIB\SSMPCOM file tailoring skeleton. Do a
search for "STUBSCAN" to see where this parm is specified. By default, this new option is not in effect.
To turn it on uncomment the line where the value is set to "YES". This feature is only available when
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generating programs via the IDE. When using the Distributed Generation Server (DGS) this setting is
ignored.

2988372 (1108572)

CICS Support

Back to the list

• The value specified in the LENGTH field of the SEND TEXT command is now honored when the target
terminal has its SOSI or PS attributes switched on. This means that trailing spaces will no longer be
removed for SOSI/PS terminals.

2884877 (1107983)

Compatibility AddPack for Visual COBOL

Back to the list

Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Visual COBOL for Visual Studio. The
run-time components are installed as part of COBOL Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

Compiler

Back to the list

• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

Documentation

Back to the list

• There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server

Back to the list

• WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.

2989188 (1108602)

Enterprise Server for .NET

Back to the list
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• A problem that caused an RTS 173 error while executing a batch job step that performed a COBOL sort
(as opposed to EXEC PGM=SORT)when the program terminated using STOP RUN instead of
GOBACK has been fixed.

3105738 (1109359)

IDE

Back to the list

• You can now open data files in RSE configured remote projects using the mfdatatools2 on the remote
machine displaying back to an X display. You can configure the remote tools display by clicking Window
> Preferences > Micro Focus > X Display. In the X Display (DISPLAY) field, type the display details. In
addition, COBOL Explorer displays the Open With Remote Data File Editor context menu item for
remote data files.

2852872 (1104085)
• Enterprise Server sign on credentials which were created on Windows when using the 32-bit versions of

Enterprise Developer or Visual COBOL for Eclipse are not compatible with the 64-bit versions of those
products, and vice versa. Users are required to re-enter credentials which are not compatible with the
current version of the product. You only need to do this the first time they are used in the current
product.

(625819)

• Disabling CICS support from the properties of a file in your project within the IDE now correctly sets the
NOCICSECM Compiler directive on that file.

File Handling

Back to the list

• A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.

2874622 (1106562)
• Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a

file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)

• New PARM option SIGN-EBCDIC documented for MFJSORT.

2880037 (1107256)
• The MFJSORT ICETOOL emulation now supports the USING parameter in the SELECT operator.

2821176 (1099529)
• An empty, space-filler record is no longer produced at the end of an ICETOOL listing file.

(622789)

IMS Support

Back to the list

• Inconsistent results returned to a GET call issued from a PROCOPT=GO application when segments
within the same database record were updated and locked by another session. Symptoms included an
invalid (GE) status code or the wrong segment returned to a GN call. This has been fixed.

2862879 (1104899)

• The IMS control page is now secured according to the IMS* entity in MFESMAC.

2877405 (1107099)
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JCL Support

Back to the list

• An emulation of the LE run-time option CBLQDA has been implemented in the form of the environment
variable MF_CBLQDA. The default is OFF, but when set ON, QSAM files can be dynamically created.

3104665 (1109251)
• A new event call to the JCL user exit (MFJUXIT) has been included. The event 'job-queued' (event code

27) occurs when a JCL job has been parsed and put on either the Input Ready queue or the Input Hold
queue.

2990395 (1108734)
• When reading commands, MFFTP now checks the charset (EBCDIC or ASCII) of each concatenated

INPUT dataset to determine if it should be translated. The output is written in the charset which
appropriate for the dataset.

2876407 (1106795)
• The PHYSFILE security setting will now be checked when a dataset entry is inserted into the catalog, or

when a dynamic PDS member is created.

2857819 (1104844)

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSI no more requires that the name of the last folder specified in the path in MFBSI_DIR matches
the name of the target Enterprise Server region. It is now possible to specify any directory path in
MFBSI_DIR. You must use the same value for MFBSI_DIR in both the Enterprise Server configuration
and for MFBSIJCL execution. When the name of the last folder specified in the path in MFBSI_DIR
does not match the name of the target Enterprise Server region, you need to specify the region name in
one of the following ways: 1. From the mfbsijcl command line, using the parameter
REGION=ESRegionName. 2. In an MFBSI configuration file, in a line containing
REGION=ESRegionName. You can specify this either in the default configuration file, mfbsi.cfg located
using the path specified by MFBSI_DIR, or using a custom location or configuration file and the
following parameter: CFG=[path]/name[.ext] See your product help for more details.

2869805 (1105939)

Micro Focus Directory Server

Back to the list

• In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.

3101625 (1109025)
• Some additional CSRF security measures have been added to the Enterprise Server Administration

HTML GUI.

3101205 (1108916)

OpenESQL

Back to the list

The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for both
ADO.NET (DBMAN=ADO) and ODBC (DBMAN=ODBC). For ADO.NET, this reduces cursor memory
consumption thereby providing optimal performance. This also ensures that, for ODBC, embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses have the same data integrity across all
databases.
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If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

PL/I Support

Back to the list

• PUT output-items of type POINTER are now output as a hexadecimal string rather than a fixed bin
integer value.

(623184)
• Enterprise Developer 3.0 includes some changes that result in a significant performance improvement

when assigning a null character string '' to arithmetic data items, pointers, and structures. In versions of
the product earlier than 3.0, pointer = ''; assigned the value sysnull(). This has been fixed and null() is
now assigned. See the product help for details about the -setnull compiler option.

(627517)

• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)

Reserved words

Back to the list

• There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:

ALLOCATE
FREE
JSON
END-JSON

SQL: HCO for SQL Server

Back to the list

• The HCOSS Assess Application Migration tool now enables you to view the original DB2 SQL and the
converted TSQL together in both the HCOSS tool itself and in any exported CSV files.

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• Azure support
• Debugging
• Enterprise Server
• Eclipse
• Micro Focus Rumba
• Resource Adapters
• REST/JSON IMTK implementation and the same-origin policy (SOP)
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• Visual Studio

Azure support

• When compiling COBOL Azure Role projects in Visual COBOL for Visual Studio 2013 you receive
warnings at build time and the code fails to execute when deployed to Azure.

To work around this issue, you need to manually add the code below to the configuration section of the
Web.config file in your project for Web Roles or in the app.config file for Worker Roles:

<runtime>
      <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.Services.Client" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.OData" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.Edm" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Newtonsoft.Json" 
publicKeyToken="30ad4fe6b2a6aeed" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-8.0.0.0" 
newVersion="8.0.0.0" />
          </dependentAssembly>
      </assemblyBinding>
</runtime>

This information is added automatically when you create COBOL Azure projects in Visual Studio 2015
or later.

Debugging

• When debugging .gnt code on early builds of Windows 10 and Windows Server 2016, execution fails
to stop at COBOL breakpoints. To resolve this, you should install the most recent Windows updates for
your operating system, as this problem is only known to be present with the earlier versions.

• When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.

• Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:

1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:
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<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
  <DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>

3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.

4. Start Eclipse from the same command or shell prompt.
• Remote debugging does not work for programs running on AIX or HP machines, if you are trying to

debug using Visual COBOL installed on a Linux machine.

Enterprise Server

• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Eclipse

• If you are upgrading your license from Visual COBOL for Eclipse Personal Edition (v2.2 or earlier) to
Visual COBOL, or from Visual COBOL Connect (v2.2.1 or later) to Visual COBOL, any existing projects
compiled to either .exe or .dll files using the old license must be updated in order to recreate
the .cobolBuild file. You can do this done by adding or removing files from the project or by deleting
the .cobolBuild file. Updating the project in this way ensures Eclipse will fully build the executable
files.

• Opening a COBOL or a PL/I project in Visual COBOL modifies the .cobolProj and .pliProj files.
Once modified the .cobolProj and .pliProj files are is no longer backward compatible with older
versions of Visual COBOL. This prevents you from opening the same projects in earlier versions of
Visual COBOL.

Note: Micro Focus recommend that you backup your .cobolProj and .pliProj filesfile before
opening projects created in earlier versions of Visual COBOL.

Micro Focus Rumba

• On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

• The embedded Rumba display is only available if you are using:

• Visual COBOL for Visual Studio 2012 with Rumba 9.4 or earlier. If a newer version of Rumba is
installed, you need to use Rumba Desktop instead.

• Visual COBOL for Visual Studio 2013, Visual Studio 2015 or Visual Studio 2017 with Rumba 9.5 or
later. If an earlier version of Rumba is installed, you need to use Rumba Desktop instead.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
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REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Visual Studio

• The Visual Studio 2017 option Lightweight Solution Load is not supported for COBOL. It must not be
used with solutions that contain COBOL projects as it could result in problems with building the projects
properly.

• In certain installation scenarios, after you install Visual COBOL for Visual Studio 2015, the COBOL
language service can be uninstalled. This results in the following features missing from the COBOL
editor: colorization, IntelliSense for COBOL and any other COBOL language support. This is an issue
with Visual Studio's MEF component cache becoming corrupted.

To resolve this issue and restore COBOL language support in the editor:

1. From a command prompt, navigate to C:\Program Files (x86)\Microsoft Visual Studio
14.0\Common7\IDE.

2. Execute the following commands:

devenv /updateconfiguration

And then:

devenv /clearcache 

Installation

System Requirements

Hardware Requirements
In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

Visual COBOL and Enterprise Developer for Visual Studio

Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 1.2GB 75MB

Enterprise DeveloperEnterprise
Developer

2.3GB 75MB
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Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Visual COBOL and Enterprise Developer for Eclipse on Windows

The disk space requirements are:

Product Maximum Disk Space
Requirements

Sentinel RMS License Manager

Visual COBOL 3.7GB 75MB

Enterprise Developer 4.5GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.

For a list of the operating systems each individual product in this package supports, check the Product
Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/
prodavail.aspx.

• Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.

Software Requirements
Note: This product includes OpenSSL version 1.0.2j.

Windows

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Visual COBOL and Enterprise Developer for Visual Studio:

This product requires Microsoft's Visual Studio - either the Visual Studio Integrated Shell or a more
advanced version of Visual Studio.

The following advanced editions of Visual Studio are required:

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)

If there is no Visual Studio installed on your machine, the setup file for Visual COBOL for Visual Studio
2012 or 2013 will install the Visual Studio Integrated Shell.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Visual COBOL for Visual Studio 2013.

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
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statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.

• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

• Visual COBOL for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has a
number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Visual COBOL for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.

Note:

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If you

choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or
the Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for
more details.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Visual COBOL and Enterprise Developer for Eclipse:

The following requirements apply to both Visual COBOL and Enterprise Developer:

• The setup file installs Visual COBOL and the 64-bit Eclipse 4.6.0.

Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
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Note: If you are installing Visual COBOL into Eclipse 4.5, or 4.6, you must install the Eclipse
Target Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

1. Click Help > Install New Software in Eclipse and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.

2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.

• Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.

• Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

• Oracle's Java Platform (64-bit) version 1.8.92 or above is required to run the Eclipse IDE. Java 7 and 8
(32 or 64-bit versions) are supported for executing JVM COBOL code and for native COBOL and Java
interoperability. You can download Oracle's Java EE from Oracle's web site and install it anywhere on
your machine.

Note: If Java 7 is installed on your machine, you can skip installing Java 8. Run the setup file with
the skipjre=1 command line option to do this.

• Visual COBOL requires:

• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.

• The setup file also installs .NET Framework v4.6.2 and the Microsoft's Visual C++ 2010 and 2012
Redistributables.

Installation Restrictions and Requirements
Before starting the installation you should be aware of the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• If, when you install Visual COBOL for Visual Studio , the machine does not have Microsoft Visual C++

Redistributable Runtime already installed, it is installed as required by Visual COBOL. The installation of
Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital signatures,
into the winsxs directory.

• If, when you install Visual COBOL for Visual Studio 2013, the machine does not have Microsoft Visual C
++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product , make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:
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1. Stop the service, using either the Windows Service Management Console GUI or from a command
line prompt by typing: net stop mf_ccitcp2 Only one instance of the MFDS or CCITCP2
service can run on a Windows machine.

2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured Enterprise Servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Downloading the Products
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing the Products
Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:

Windows

1. Run the productname.exe file and follow the wizard instructions to complete the installation.

After Installing

Visual COBOL and Enterprise Developer for Visual Studio

You are now ready to run Visual COBOL or Enterprise Developer. From the Windows taskbar click Start >
All Programs > Micro Focus Product Name > Product Name for Visual Studio. (The Start menu is not
available on Windows 8, Windows 8.1, and Windows Server 2012. You use the Start screen to invoke
programs.)

Refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

• To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to local
help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help Browser.
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Visual COBOL and Enterprise Developer for Eclipse

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Installing X Windows on Windows

Some features of Visual COBOL for Eclipse and Enterprise Developer for Eclipse on Windows require an X
Windows installation, so Micro Focus ViewNowX is provided with the product. To install, run the file
ViewNow_X_Server.exe in your Visual COBOL installation. By default this will be in the
%ProgramFiles(x86)%\Micro Focus\Visual COBOL for Visual Studio 2012\ViewNowX
folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing

Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
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Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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